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1 Introduction
This guide will detail the different operating procedures that the person in the control room may be expected
to undertake, using the CathexisVision Client software. This does not include the setup’s that take place, either
in the setup tab, or via the menus. For this information please refer to the Setup Manual.

For example this manual will deal with questions such as “how do I zoom in a PTZ camera”, and “how do I
review previously recorded footage?” The Setup Manual, on the other hand, will provide information on how
one would add and setup a new camera, or add a motion detection algorithm to a camera.

Opening a Connection to a Site

The CathexisVision Client is not tied to any particular site, and as such, the user first has to open a connection
to the site they wish to view.

Clicking on File –> Open Site will open a list
of all sites that have been added to the
Viewing PC. Select the site you wish to view.

After selecting your site, you should be prompted to enter in your
login credentials.

If the default is to log in at a
certain level, and you wish to
login with your specific user
click on Site –> Change login
and enter your credentials.
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2 Cameras Tab
This section will deal with the Cameras Tab, which is the tab through which the operator will view live footage,
as well as review recorded footage.

Open the Cameras Tab

After opening a connection to the desired site, as described above the operator must open the Camera Tab.
There are three ways to do this:

Option 1

Click on File –>
Your_Site –> Open
tab –> Cameras Tab

Option 2

Click on Site –> Open tab –> Cameras

Option 3

This option will only a tab for site
open in this tab. Right click on the
site’s open tab and click Open
tab–> Cameras
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a. Main Screen Areas
The following presents a brief introduction to the various features of the Cameras Tab, which will each be
dealt with in deeper detail, further on in the document.

1

2

3

4

6

5

7

8

9

1 The menu bar provides menu options for the current desktop, and shows your access rights. These menu
options change on a tab-by-tab basis.

2 These are the various tabs (camera, database, and setup) for one or multiple sites.

The colour of the text in the tav indicates its connection status:

Each Site can be custom-configured to automatically load certain tabs, when a connection is made to the Site
(this is configured from File –>Enterprise Manager –> Right Click Site –> Properties). To close a tab click on .

3 The cameras panel contains the individual panels on in which cameras are viewed. Selected cameras are
outlined in red; unselected cameras have no outline.
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4 The timeline will show the current time of the selected panel/s. The white area indicates time that has
passed; the grey area indicates time approaching; the point between them indicates the present time.

5 The review controls panel hold the tools used in reviewing, and archiving, recorded footage, for one or
multiple cameras.

6 The resource panels mouse over options include a number of options:
Lock display. Some CathexisVision events will be setup to switch the camera panel to view cameras
related to the event. Clicking on this lock will enable/disable this feature. An unlocked display ( ) will
switch; a locked display won’t.
PTZ Controls. This will pull up a basic PTZ control menu. For a, potentially, more detailed menu see
the note on Number 7 (below).
Event Notifications.

Configure Resource Panel.
Resource Panel Filter.

7

The panel selector is a dropdown bar for selecting from a
variety of panels:

 PTZ.
 Resources.
 Contacts.

8 The Local Resources bar (top right) shows the status of local hardware resources:

Local default audio input (e.g. your microphone)

Local default audio output (e.g. your speakers)

Local monitor
When active, these resources display bright green, and when inactive they are grey. If you run your cursor over
an active resource, a “tooltip” will provide information on the activity. For example, mouse-over a green
monitor to see what camera is displaying to that monitor. If you have many local resources, they will be
arranged in a scrolling area, with left and right scroll arrows.

9 The status bar, at the bottom on the interface provides relevant information:

Notification Icon Notification Description
The username, and their access level.

This represents the main license of the unit.

The distributor of the license.

The cameras notification will only appear to alert you when
cameras are down. Clicking on it will allow you to see which
cameras these are.
The Tamper icon indicates that one or multiple cameras have
been tampered with.
Click to view the list of tampered cameras.
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If you have been granted the access rights, you may reset the
tamper here, as well.
The licensing notification will be permanently present, but will
change colour depending on licencing status.
Green indicates a healthy licensing status.
Orange indicates that there are demo licenses that are due to
expire.
Red means either missing or expired licenses.
The performance monitor notification is permanently present,
and will allow you to view performance statistics. See the
Appendix of this document for a full explanation.
The connection status icon is permanently present, and
indicates the status of the connection to the current site.
Video Analytics notification. Warns the user when an error has
occurred which involves one or more of the video feeds on a
site.
Failover notification will provide information about the status
of existing failover servers.

b. Cameras Panel Overlays and Context Menu
This section will cover the different overlays that are visible on each panel, and the options available in the
context menu.

Overlays

Live
Green text shows that the stream you are
viewing is live.

The text in the top left (Highway 1 here) is
the camera’s given name.

The timestamp is seen on the bottom
right.

A present in the top right hand corner
of the panel indicated that the camera is
currently recording to one of the
databases.

Review
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Red text indicates that the video in this
panel is being reviewed, from previously
recorded footage.

The text in the top left (Highway 1 here) is
the camera’s given name.

The date, and, timestamp is seen on the
bottom right.

Mouseover Overlay
When you hover the mouse over a camera’s panel you will see the little black- arrow icon appear on the left-
middle of the panel. Clicking on this icon will expand the menu, as you see below:

Click on to allow you to change which
algorithm information is overlaid (if there
are algorithms set up).

Clicking on will allow you to select
between available video feeds for the
selected camera. (This is very useful when
you need to view a camera over a slower
link, and the camera provides a lower
format/resolution video feed.)

Note: When you are reviewing video you will also see the database icon in the list. This will allow you to
select which database you want to review video from. This is useful if this camera records to multiple
databases.

Review Button Overlay

Under Settings Video Display there is an option called .
When checked you will see the following overlay when you
mouse-over a camera panel where the video is currently being
reviewed:

Live Context Menu

To see the context menu, middle-click the mouse on the camera panel of your choice.
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Start/Stop audio will start/stop a cameras audio feed streaming to the
device.
Video format will allow the user to select which of the cameras video
streams (which format/resolution) they wish to view.
Hide/show privacy zones, will allow configured CathexisVision privacy zones
to be shown/hidden in live and review feeds.
View transform allows you to transform images for cameras with special
lenses. (E.g. 360 degree cameras.)
Overlays will allow you to view the different analytics algorithms that have
been applied to this camera’s feed, live in the Cameras Tab.
Help will pop-up a help window on Digital Zoom, and PTZ Control within this
panel.
Switch to review/live will allow you to switch back and forth between live
and review footage.
Shrink panel will reduce the size of the camera panel.
Resize panel gives you more resizing options.
False colour will change the colour of the image to false colour.
Clear panel removes the camera/s from the currently selected panel/s.
Export snapshot… will allow you to copy the current still-image from a
camera to your clipboard, print the snapshot that is currently on the
clipboard and save the snapshot to disk.
Cameras fullscreen will fill the entire screen with the Cameras Panel;
creating a Video Wall. Pressing ESC, on the keyboard, will exit.

Review Context Menu

Start/Stop audio will start/stop a cameras audio feed streaming to the
device.
View transform allows you to transform images for cameras with
special lenses. (E.g. 360 degree cameras.)
Select database will allow you to define which database the specific
camera will record to.
Hide/show privacy zones, will allow configured CathexisVision privacy
zones to be shown/hidden in live and review feeds.
Overlays will allow you to view the different analytics algorithms that
have been applied to this camera’s feed, live in the Cameras Tab.
Switch to review/live will allow you to switch back and forth between
live and review footage.
Shrink panel will reduce the size of the camera panel.
Resize panel gives you more resizing options.
False colour will change the colour of the image to false colour.
Clear panel removes the camera/s from the currently selected panel/s.
Export snapshot… will allow you to copy the current still-image from a
camera to your clipboard, print the snapshot that is currently on the
clipboard and save the snapshot to disk.
Search will allow you to perform a snap search of the database for
frames similar to the current image. See the Snap Search section for
details.
Cameras fullscreen will fill the entire screen with the Cameras Panel;
creating a Video Wall. Pressing ESC, on the keyboard, will exit.
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Select, or Move, Cameras

1. To select a single camera left-click on it.
2. To select multiple cameras, hold down CTRL while left-clicking on the cameras you wish to select
3. To move a camera, from one panel to another, right-click-and-hold the camera and drag it to the new

panel.
4. CTRL-A will select all cameras in the Cameras Tab.

Digital Zoom

You can zoom in digitally on cameras that have no physical PTZ capability. This is done by selecting the specific
camera in the Cameras Panel and doing the following:

 Zoom in/out

Scroll the mouse wheel.

 Zoom to area

While holding the shift key, drag-select an area using the left mouse button

 Pan

Pan the image using the left mouse-button. This is done by holding down the left mouse button, while moving
the mouse.

c. Snap Search
While in review mode, you will be able to search the database recordings for frames which match the current
still-image on the screen.

To perform a snap search, the camera must be in
review mode. Open up the context menu and select
Search Snap search.

This will bring up the Snap Search window below, in
which all frames matching the current image are
displayed.
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Snap Search Window

Frame Display. Choose how many frames to display on the page.

Time Range Control. Set the time range of the search, zoom in/zoom out to narrow or widen the
time range, or go back and forwards between time periods.

Frame Area. All frames which are similar to the image you used to search will be displayed in this
area.

Timeline. Use this timeline to navigate between relevant frames.

 Time Range Control

See the table below for an explanation of the time range control buttons.
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The current time range in which frames are being viewed. If the time range is
changed, it will reflect here.

Set the time range. Clicking this icon will bring up the window below, in
which the range may be set.

Set a Start and End
time range.

to Accept

to Cancel.

Zoom in to narrow the time range, zoom out to widen the time range.

Go next/previous time periods. Depending on what you have set your time
range to using the clock icon above, you can navigate between time range
periods using these buttons. The length of the period is determined by how
narrow/wide your time range has been set to.

 Frame Area Controls

In the frame area, a number of controls are available. These are:

Double-click a frame
Double-clicking on a thumbnail will start playback from that frame in the CathexisVision GUI review, but the
Snap Search Window remains open.

Right-Click a Frame

Play from here will open an embedded video player and start playback of
the recording from the frame selected.
Show day will display frames from that day over 24-hours (midnight to
midnight).
Show 11am to 12pm: This shows frames from the hour of the selected
frame. Thus, this time range will change according to the time of the
specific frame you have right-clicked on.
Show hour back will move the time range an hour back and display the
relevant frames.
Show hour forward will move the time range an hour forwards and
display the relevant frames.

Search Between Frames
You are also able to search time periods between specific frames on the page by clicking-and-dragging.
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Simply click on the frame you want
to start your search with, and drag
to the frame you want to end your
search with.

A blue line will visualize this, and
the time between the two frames
will be displayed in blue.

You may search between any
frames, in any direction.

 Timeline

The snap search timeline functions in the same way as the CathexisVision GUI timeline.

Click anywhere on the timeline to go to that time.

Indicates there are recordings during the highlighted time period.

The green square on the timeline indicates that the position of matching frames. Click
on it to display.
Once a frame is selected in the frame area, the corresponding green square will turn

orange.
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d. Review Controls (Timeline and Review Controls Panel)
This section will deal with reviewing video in CathexisVision. There are two sections that may be used to
review recorded footage. The Review Control Panel, and the Timeline.

Review Control Panel

Note: When you click the icon, to enable review, it will change to an icon. Clicking the running-man
icon will return you to live view.

 To Review Footage from a Certain Date

Using the Time/Date Wheel
To go to a specific date, select the camera/s that you wish to review, and
click on the arrows of the Date/Time wheel until you have settled on the
correct date/time.

Using the Timeline
To move to a date and time, using the timeline simply left-click and hold anywhere on the timeline, and drag
the timeline to the time/date you desire.

 Selecting a Period for Review

After finding something of interest, you may wish to loop through the recorded footage around that event.
(This can also be useful when selecting footage for archive). You may move the timeline around by left-click-
dragging it.
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There are two ways to select the period which you want to review.
1. Tagging: Click on the icon to tag the start of your selection. Then navigate to the end of your

desired period, and click on the icon, to tag the end of your selection.
2. Shift-selection: This is done by holding down the SHIFT key, while click-dragging your selection with

the left mouse button. Your selection will look like the image below.

The selected areas will appear as you see to the left. By default it will be set to loop.
This can be seen when looking at the loop icon.

Means that it will loop, to the beginning of the selection, as it gets to the end of the selection.

Means that the video will continue to play past the end of the selection.

Timeline

The timeline at the bottom of the GUI indicates where in time the currently selected cameras are.
Note: while you may review legacy video in CathexisVision 2015 and onwards (recordings made on pre 2015
systems) the timeline will remain blank.

 Live View Timeline

The live view
timeline simply
show the current
time at the
intersection
between white and
grey.

 Single, and Multiple, Camera Review Timeline

When reviewing a
camera’s recorded
video you will see
the timeline change
to show red blocks.
These blocks on the
timeline represent
recorded events.

If you have selected
multiple cameras to
review they will
appear stacked on
the timeline.
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Note: You may only view two cameras’ timelines at once, on the docked . To cycle between them click on the
icon at the bottom right of the timeline. If you wish to see more you may detach the timeline from the GUI.

This is described below.

 Detached Review Timeline

To detach the timeline from the

GUI click on the icon, at the
top right of the timeline. To
reattach the timeline click, in the
same place, on the icon.

 Synchronised/Independent Review

By default all reviews are synchronised, when you have selected multiple cameras for review. It is possible to
review cameras independently.

When already reviewing a camera, if you middle click on a camera’s panel you
will see the following options in the context menu.

Start new review group will add this camera to a separate group of review cameras, which will be
asynchronous to the original review group. The new review group is indicated by the tag on the top-right of
the video. Each review group will get its own colour.
Add to review will add this camera to the already existing review group. As you add review groups the number
of options here will increase as a result.

 Timeline Actions

Zoom in on Timeline
There are two ways to zoom in on a section of the timeline.

1. By moussing over the timeline (during review) and rolling the mouse-wheel forwards. To zoom out roll
it backwards.

2. But shift-selecting a section of the time line.
This is done by holding down the SHIFT key, while click-dragging your selection with the
left mouse button. Your selection will look like the image to the left.
To zoom in on this selection click on the icon.

Move the Timeline with the Mouse
You may move backwards and forwards in time, by left-click dragging the timeline in the direction that you
want to travel.
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e. Panel Selector
Clicking on the drop down menu of the Panel Selector will
show you four options: Adjacent Cameras, PTZ Controls,
Contacts, and Resources. The Contacts are special site
contacts, setup by your administrator. The Resources are the
site resources, such as Cameras, Relays etc.

Select Cameras from the Resources Panel

The resources panel will the one from which you select which cameras you want to view in the Cameras Panel.
There are a few ways to do this.

 Double-click a camera in the Resources panel

Double-click a camera in the Resources panel to load it Live
into the camera panel that currently has focus (is selected).

 Drag a camera from the Resources panel

Left Click on a camera, holding down the mouse button, and
Drag a camera from the Resources panel (first drag the
camera horizontally left, and then to the panel that you want
to view it in)

 Drag a group of cameras from the Resources panel

From release 5042c2, January 2011, you can select a group of
cameras from the resource pane and drag them onto the
camera display (for camera tab or multisite tab). This is a
quick and convenient way to populate a screen with cameras.

This is achieved by selecting cameras while holding down the
CTRL button on your keyboard, then Dragging them across.

Reset Camera Tamper

Depending on your access rights, you may be able to reset a camera tamper if that is being tampered with.
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In some cases, a camera will remain in a tamper state until the camera has been restored to its normal state;
this may include the physical removal of the tamper such as refocussing the camera lens or correcting the
camera’s position. However, when necessary, you may need to clear the tamper state from within the
software.

In the Resources Panel, a camera tamper icon (red hand) will appear in front of camera that has been/is being
tampered.

Right-click the tampered camera and select Reset camera tamper.

Mouse Over Options

When you hover your mouse over the Resources Panel you will see the following option set appear:

 Lock Display

Lock display. Some CathexisVision events will be setup to switch the camera panel to view cameras related to
the event. Clicking on this lock will enable/disable this feature. An unlocked display ( ) will switch; a locked
display won’t.

 PTZ Controls

To bring up the PTZ panel, click on the icon in the Mouse Hover Options, in the Resources Panel. (Note:
Selecting the PTZ option from the Resource Panel dropdown menu will give you more PTZ options.)

With a Pan-Tilt-Zoom (PTZ) camera an operator can manipulate the camera's direction, zoom, focal distance
and amount of light. A PTZ camera is indicated in the Resources panel with an icon. He/she can also control
pre-configured camera views called “Presets”.
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This panel provides controls for camera presets, and a
software joystick for interactive control of the camera.
The Preset controls enable you to set Presets and go to
Presets.
The curved grey buttons surrounding the joystick enable
zooming in and out, focussing closer or further away, and iris
control – lightening or darkening the camera image.
The Manual button is for manual override of the dome (to
override automated patterns, local tours etc.). The Auto
button relinquishes manual control, to let the system regain its
automated configuration.
Note the green text on one of these buttons. This indicates
which mode currently applies – Manual or Auto. In the
example at left, the system can function automatically. The
screen may change unexpectedly as it runs patterns, tours, etc.

PTZ Panel

To pan left / right from the PTZ panel

Drag joystick left / right

To tilt up / down from the PTZ panel

Drag joystick up / down

To move the camera faster from the PTZ
panel

Distance determines speed - drag joystick
out, in required direction

To move the camera slower from the PTZ
panel

Distance determines speed - drag joystick
closer in, in required direction

To zoom in / out from the PTZ panel
Watch the live camera as you press the Zoom +
and Zoom - button

To focus further / closer from the PTZ panel
Watch the live camera as you press the Focus + and
Focus - button
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To go to a preset from the PTZ panel
Select the preset from the dropdown, and then
click GO
> The camera view will change to the preset.

To set a preset from the PTZ panel
1. Select the preset from the dropdown,
2. Use the joystick controls to establish the camera
view, zoom, focus and light (iris).
3. Click SET.
4. Go to this preset to check it.

To relinquish manual control of the dome /
PTZ camera from the PTZ panel
Click Auto. > If your system runs remote tours
automatically, or switches display based on events,
these automated responses will take over.

Pause a PTZ Tour
PTZ tours can be paused/restarted, per camera. This
is achieved by right-clicking on the camera in the
resource panel and selecting the "Pause/restart PTZ
tours" option.

To lighten/darken the live camera view from
the PTZ panel
Watch the live camera as you press the iris+, or iris
– button. You will see the image lighten or darken

To gain manual control of the dome / PTZ
camera from the PTZ panel
(This applies if you system runs remote tours
automatically, or switches display based on events)
Either click manual, or simply move the software
joystick

Individual Camera Panel Zoom Options
Note: If the camera supports any of the above then you can switch between digital and PTZ
control using the icons on the bottom-left of the camera panel.
Zoom In/Out
Scroll the mouse wheel. Holding down the shift key
while scrolling the mouse wheel will do an
accelerated zoom

Zoom to Area
Holding the shift key select an area using the left
mouse button

Zoom out completely
Press the Z key or; hold the left mouse-button
down, for half a second, and select the zoom out
menu option

Center on Point
Holding the shift key press the left mouse button; or
Hold the left mouse-button down, for half a second,
and select the center on point menu option.

 Event Notifications

If your administrator has set up Event Notifications for this unit then you will receive notifications based on
these setups.
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1 A Message Notification

2 A Popup Notification

1. An audio notification. This is a sound clip that gets
played when the event triggers.

2. A message notification. This is a message that gets
displayed in the notification area of the resource panel.
It's meant as an unobtrusive feed of events (To show the
notifications area, click the icon at the bottom of the
resource panel. This can be resized). If an event has
camera resources associated with it then the notification
can be double-clicked and the cameras will be shown in
the camera view.

3. A popup notification. This is a popup message box that is
shown when the event triggers.

Clicking on the database icon in the notifications pane, will open that camera in the cameras panel at the
point, in the database, where the event occurred.
Clicking on the recycle icon will either clear the notification (if you click on the recycle icon attached to
the notification); or clear all notifications (if you click on the one at the top of the Notifications pane).

 Configure Resource Panel

This section allows the administrator to setup the various resources that are pulled through into the resources
panel. These include the Unit Resources, Camera Layouts, Camera Sequences, Layout Salvos, and Site Actions.

Note: Since this is part of the Site Configuration it has been dealt with in the full Setup Manual, for further
information refer to this manual.

 Resource Panel Filter

Clicking on the resource filter icon will bring up the
filter options.

The checked items will appear in the resources
panel; the unchecked items will not appear.

This is useful in sites that have many resources that
the user may want to filter when looking for
something specific.
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f. Adjacent Cameras
As an operator you are able to navigate between adjacent cameras (cameras that are physically next to each
other) from live and review mode, provided an administrator has set up adjacent camera mapping.

This feature is beneficial as you will be able to follow a person in real time using linked cameras using red
direction arrows which appear over the camera image as overlays.

Navigate

Click the red arrows to navigate to cameras to the North/South/East/West of the current camera.

 View Camera Thumbnails

To view thumbnails of the cameras in live/review mode instead of the
camera names, click the Resources dropdown menu and select Adjacent
cameras.

As you navigate, the relevant camera will be selected in the Resources
list.

You may also double-click on a camera name from the Resources list to
navigate to it.
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3 Archiving
Archiving is a facility to enable you to select recordings and copy them to archiving media, such as USB key,
hard drive or CD/DVD. Archived recordings retain their authenticity and can be verified as authentic
(unaltered) on replay.

Creating an archive is done from within the Cameras tab; reviewing and exporting an archive all occurs in the
Archive tab, or the CathexisVision Archive Player.

Note:
When archiving a video stream which has Privacy Zones, the archive file will have the zones included only if
the feed is set to “Show privacy zones” at the time of archiving.

a. How to Archive

Archiving

 Select Video to Archive

There are two ways to select the period which you want to archive.
1. Tagging: Click on the icon to tag the start of your selection. Then navigate

to the end of your desired period, and click on the icon, to tag the end of
your selection.

2. Shift-selection: This is done by holding down the SHIFT key, while click-
dragging your selection with the left mouse button. Your selection will look like
the image to the left.

Click on the icon to start archiving your selection.
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 Apply Archive Settings

Archive Tab
Destination: Choose whether to
archive video to Folder or straight to
Optical disc. archiving to Folder,
select your path and Output type.

The filename may be defined
manually – the default name will be
the current date.

Select a Password option from the
dropdown menu; this password will
have to be entered when reviewing
archives.

Clicking on Set description will allow
you to give this specific archive a
title.

Click on Start to archive the
selection with these settings.

Settings Tab
You can make archives exportable or not exportable, by checking the box.

Use the Copy archive viewer option when the archive will be viewed on a
computer that does not have the CathexisVision interface installed.

Note: The option to set up archive profiles, watermark profiles, and archive passwords, is configured in Setup
Tab General Site Setup Configure archiving. This setting is controlled by the administrator of the Site.
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 Complete the Archive process

While archiving the interface will give
you moving progress bars to indicate
the progress of the archiving process.

If you chose to copy the archive
viewer in the previous step, you will
see that copy progress here.

b. Review and Export Archives

Select the Archive viewer from the File Menu.

Alternatively, open the CathexisVision Archive Player from the shortcut on
the desktop to review archives in the standalone viewer.
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 Open an Archive Folder and Select an Archive to Review

Once in the Archive viewer, you may navigate to and from archive

folders using the icons.

Once you have opened the folder, the list below the icons will be
populated with the archives contained in that folder.

Select the archive you wish to view and it will be displayed in the
camera image to the left of this panel.

If you set a description when archiving the video, it will appear in the
white space below the archives.

When you select an archive to review, the recordings, listed by camera,

will appear in the Camera box. Click on to set Start and End time
columns to this view.

If there is a password set on an archive, you will have to enter it:
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 Right-Click in Archive Panel

In the archive panel (the panel in which archives available for viewing are displayed), you may right-click on an
archive for options.

Inspect will display the meta-information of the archive. See below.

Verify will confirm whether the archive is authentic or not. See section C below.

Open file location will open up the location of the selected archive in File
Explorer.

Inspect an Archive
To inspect an archive for its meta-information, right-click on the archive in the archive panel and select
Inspect. This will bring up the window below:

User will display the username of the operator who performed
the archive.

Description will show the description of the archive (if set).

Password will show Encrypted if a password is set, and Note
set if not.

Watermark will show the watermark of the archive (if set).

Archive time will show the time and date that the archive was
performed.

 Exporting Snapshots from Archive Viewer

When reviewing archived recordings, you have the option to export snapshots. Right-click on the image and

select . This will bring up the Export snapshot window, which provides you with the following
options:

Print snapshot.

Save snapshot to folder.

Copy to system clipboard.

Copy to Cathexis clipboard.

This will overlay the name of the camera in the top-left corner of the camera image.

This will overlay the time of the recording in the bottom-right corner of the camera
image.
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Click once you have exported the snapshot as desired.

 Export Archive

Depending on whether this is option
is enabled by the site administrator,
you may export an archive, or
selection of an archive, either as
another archive, or as a media file.

To export the video as a media file,
click on the dropdown menu for
Output Type, and select Media file.

Note: If exporting as an archive file, password settings will apply when reviewing the export. If exporting as a
media file, password settings will not apply and will be greyed out. Passwords are set/controlled according to
archive profiles by the site administrator.
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c. Verify Archives

CathexisVision 2017 has introduced a verification feature which provides a report on the authenticity of an
archive for security reasons. Archives may be verified from the archive viewer in CathexisVision (filearchive
viewer) or from within the CathexisVision Archive Player.

Should there be a query regarding the verification, operators may copy the verification result and email it to
Cathexis support for help.

Please note:
Sub-archives (archives of archives) do not contain any signatures generated by the original NVR that sourced
the video data. The authenticity of these archives cannot be verified by Cathexis.

Verify an Archive

Once you have opened the file location of your archive in either the
archive viewer or the CathexisVision Archive Player, right click on the
relevant archive. Select Verify.

Once you click Verify, the software will determine whether or not the archive is authentic. The two following
reports are possible:

Archive verified Archive failed verification

Note: Archive verification reports may be copied and emailed to support@cat.co.za for help or queries.

mailto:support@cat.co.za
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4 Layouts and Sequences (Video Wall Menu)

a. Video Wall
In pre-5403b software this menu was titled the Layout Menu,
and only contained setup information for Layouts.

A Layout defines how the cameras appear on the screen, in the
Cameras Tab. Including which cameras are shown, and how
much space they take up on the screen.

A Sequence is a cycle of individual cameras that will run, on a
timer, in a single viewing pane, in the Cameras Tab.

The Switch Display Settings for this tab will define the
behaviour of the currently open Cameras Tab, when video
information is sent to the Client Station with an alarm.

Note: this menu option will only be present when you are viewing a Cameras Tab.

Layout

A Layout defines how the cameras appear on the screen, in the Cameras Tab. Including which cameras are
shown, and how much space they take up on the screen.

 Create new Layout

To create a layout, organise your cameras on the screen as you desire (double-left-click to expand; single-right-
click to reduce). Then click on —>New. Give the Layout a name, and click OK. (you can use Layouts
created in the Cameras Tab in the Monitors Tab, and Visa Versa.)

 Recall a Layout

To bring up a list of existing Layouts, click on and select the layout name that you desire.

 Overwrite Layout

Clicking on , and selecting on one of the Layouts in the list, will overwrite that Layout with
the current panel organisation.



005-20160810-102 August 10, 2016 Page 30

 Manage Layouts

Clicking on will bring up the list of existing
Layouts for you to manage.

From the management list you may either delete the Layout
or enter the Layout Properties window.

These are both done by right-clicking on the Layout in the
list.

In the Layout Properties window you may change the
Name, and User ID of the Layout, as well as the User Access
Level required to view, or edit, the layout.

Note: if you have limited access rights, you won’t be able to
change these settings.

 Resize Layout

Clicking on will give you the ability to change how many
cameras are arranged on the screen.

You may define how many cameras there are per row, and per column.

The maximum amount of cameras you may have per screen will be an 8*8
matrix. This gives you a possible 64 cameras per Layout. (This would
require an incredibly large screen to be practical though.)

Sequence

A Sequence is a cycle of individual cameras that will run, on a timer, in a single viewing pane.

 Sequence Manager

Clicking on the icon will bring up the
Sequence Manager.
To edit a Sequence, select the existing
Sequence and click Edit. To create a new
Sequence click on New. This will bring up
the Sequence Editor.

 Sequence Editor

You may access the Sequence Editor, where you can create and edit sequences, via the Sequence Manager.
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Name your Sequence appropriately.

The left hand panel will hold a list of
available cameras.

The right hand panel will hold a list of
cameras that are included in the
Sequence.

Sequence Editor Procedures
Add a camera to a Sequence You may:

-double-click on a camera in the list of available cameras.
-Or click-drag one, or multiple cameras, across into the Sequence list.

Remove a camera Right-click on the camera and select Delete.
Set the duration of a camera
for each loop of the
Sequence

-Right-click, and select Set Duration.
-Enter the duration in seconds, and click OK.

Looping If the option is checked the Sequence will run indefinitely, if it is
unchecked the Sequence will run once.

Change the order
Select a camera and use the arrows to move that camera up or down the
order.

 Recall Sequence

To recall an existing sequence click on to bring up a list of all existing sequences. Click on
the sequence you wish to run.

Switch Display Settings

This will define how your cameras tab responds when there is an event on the site that sends video and
information to the Cameras Tab of the viewing client.

Note: The Switch Display Settings that you set here are for the currently open tab only

Lock Display
Will prevent the Cameras Tab from displaying any video
feeds sent to it by the Event.

Restore display after
Will define how long after switching to the Event Cameras
the Cameras Tab will return to the original display settings.

Don’t restore display
Will leave the Cameras Tab on the Event Cameras until an
operator, or administrator, resets the display.

Only Switch Local Cameras
Will only switch to Event cameras originating from a local
site.
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Note: you may also either lock , or unlock , the currently opened Cameras Tab by clicking on the little lock
located at the end of the Timeline on the Review Controls.
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5 Database Tab

a. Database Tab

To open the CathexisVision Database Tab select Site—>Open Tab—
>Databases

b. Find an Entry

1. In the Database Tab, click on the icon, located in the
bottom right hand corner.

2. Select the date and time:

The list of database entries will have been pared down to beginning with the event closest to the time you
selected, and a few subsequent entries.
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c. Filter a Database to Locate Recordings (pre-2015, and Integration
Databases).

Pre-2015 databases, and integration databases, will allow for filtering when viewed from later CathexisVision
clients. There are three major filter types: Filters, Field Constraints, and Time Constraints.

Note: All filtering is based on AND/OR options.
AND If you apply Filter A AND Filter B, the result will contain only those Events in which both Filter A and

Filter B are true.
OR If you apply Filter A OR Filter B, the result will contain any Event in which Filter A is true, plus any Event

in which Filter B is true.

Note however that within a single filter you cannot use both functions – so you cannot apply “Filter A AND
Filter B OR Filter C”. (It must either be all AND filters or all OR filters.)

 Add/Remove a Filter

Click on to add a filter.

Click on to remove a filter.

 Enable a Filter

In order to have any of the Filters active you need to check the
relevant filter box at the bottom of the filters dialogue.

Note: you may further constrain results, by making Filters and Field Constraints AND/OR dependant. For
example you may have a search that  requires that the , or you may have
it set so that the .

Filters Tab

If event
has camera
Camera n

These are the primary sorting lists. The blue underlined style indicates that they are options.
Click to see a pop-up list of the options. You can choose from the following:
Has camera > (then choose camera from Camera Name dropdown list)
Has audio > (then choose audio input from Audio Input Name dropdown list)
Is tagged

and

This is a logical parameter for multiple filters. It may be “and” or “or”. It only appears if you
have more than one filter. By default it is “and”.

and

The filter results must match all of the filters. For example, if we have

Then the result is only those Events that are Tagged, that also include Camera 5
content, and that also include Audio Input 3 content – probably a short list.



005-20160810-102 August 10, 2016 Page 35

or

The filter results must match any of the filters. For example, if we have

Then the result is all events with Camera 5 content plus all Events that are tagged
plus all events that have Audio Input 3 content – probably a long list.

Field Constraints Tab

This tab is only visible if you have a streaming text data application installed, in which case you see these text
data field filters. They include the fields that have been identified in the text data streaming setup. i.e. on this
tab you will see the fields that you have customised for the text data application.

Examples of text data are the data streamed from till transactions (transaction number, purchase amount,
time, number of purchased items, etc.), and data streamed from Access Control applications (name, time,
employee number, etc.). This data is stored as different “fields”. It is possible to constrain filtered results based
on various decisions with these fields.

The principle remains the same as the Filters tab, where you create a filter and then change its parameters
using dropdown options (see above). The nature of these parameters depends entirely on your custom
application.

Time Constraint Tab

There are a number of different ways to constrain the time these are:

Note: to modify the times click on the Date/Time hyperlink and enter in your parameters in the dialogue that
pops up.

d. Replay an Associated Recording
CathexisVision is capable of associating video footage and other data with database entries. When reviewing
associated footage there are two options. The user may review the video clip associated, or they may view the
video frame at the point that the event was triggered.
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Review Trigger Frame

To review the trigger frame, left click on an entry, and if the

icon is present in the panel below, double-click on it. This
will bring up the dialogue to the left.

Motion will show where the motion occurred in the image.
Mask will show what areas of the image are covered by the
algorithm which triggered the database entry.

Review Event Video

To review the video associated with a database entry, either double click on that entry, or on the icon in
the entry’s details.

 CathexisVision Controls

CathexisVision database review uses the same control schema as the timeline review used in the Cameras
TabReview Controls section.
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 Pre-2015 Playback Controls

When reviewing video from pre-CathexisVision 2015 sites the controls will be as follows:

e. Archive Selected Database Recordings
Archiving video from the database follows the same process described above, in the Archiving section of this
document.

Note: When archiving a video feed that has Privacy Zones enabled the privacy zones will appear/not appear in
the archived video, depending on whether they are enabled in the feed at the time of archiving. (They may be
enabled/disabled by right-clicking on the feed of video being reviewed via the database tab.)

f. Print an Image from a Video Replay
To print a specific frame from video replay, you may middle-click anywhere on the on the image, and select
print.
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6 Monitors Tab
The monitors tab is a tab that gives you full control over the Video Wall. Here you can change the layout, and
define camera Sequences, and salvos.

You will not see any video playing on the interface. You will see the names of cameras where they are placed
in the layout.

Open a Site on a Screen

The list of monitors that you see will be representative of the number of monitors that have been added to
servers on the site.

To Open a monitor from a site, select one of the available
Monitors. Then click the Sites list:

Then select your site.

The Monitor with a red border will be the Monitor whose camera Layout is displayed below it.

Layout

A layout defines how the cameras appear on the screen. This includes which cameras are present, to how
much of the screen an individual camera takes up.

Recall a Layout
To bring up a particular layout on a screen, click on the icon, and select the layout name that you
desire. The Layout
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Sequence

A Sequence will run a set of cameras, in single camera panel.

Run a Sequence - Click on a camera panel.

- Click on
- Select the relevent Sequence from the drop down menu.

Salvo

A Salvo is a set of Layouts. This means that the Layout of cameras on the monitor will change, running through
a set order, using the pre-defined Layouts.

Run a Salvo - Click on a Layout panel.

- Click on
- Select the relevent Salvo from the drop down menu.

Virtual Cameras interface

The virtual cameras interface is the
interface where you

 See the Layout that the cameras
will take on the Monitor that you
have selected.

 See what cameras are in which
panels.

 May control the overlays on
each camera

 And use the Playback controls to
review video on the Monitor.

 Individual Panel Settings

To change the settings of an individual panel middle-click on the panel, this will bring up the following menu:

Set No Camera will make this panel blank

This will bring up the recordings of the selected camera. For information on reviewing the
camera see the section below, on Review Controls
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This will cycle through the available video feeds that are available on the selected camera.

 Review Controls

Note: When a camera has been selected its
border, and camera name, will become Green:
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7 Audio procedures

A microphone and speaker on the menu bar (at the top right of the screen) represent your two
local audio hardware resources, local audio input and local audio output.

These two icons represent the state of your local microphone and speaker - when a resource is being used, its
icon is bright green in colour, and when the resource is inactive, and its icon is grey.
You can look at these icons to see the current state of audio interaction, and you can run your mouse cursor
over a green icon for information on the activity. However, the actual control of audio is from icons in the
Resource Panel and Live remote cameras:

 To Listen to a Remote Site by Means of the Resource Panel

Open the Resource panel for the remote site, and double-click the remote microphone that you wish to listen
to. Your local speaker goes green , indicating that your listening is in progress. If you move the cursor over the
speaker, you will see a tool-tip describing the remote audio input that is being listened to. You should hear
sound from the remote site.

 To Stop Listening to a Remote Site by Means of the Resource Panel

Right click your local speaker, and choose Stop.
Your local speaker goes grey, indicating that your listening is no longer in progress.

 To Listen to Remote Live MPEG by Means of the Middle-click Camera Menu

A Live remote MPEG camera with audio will display a small
microphone icon before the name on the camera display:

Middle-click the camera image, and select Listen from the menu.
You will see the icon change from grey to green, to indicate activity. You should also hear sound on your local
speaker

 To Stop Listening to Remote Live MPEG by Means of the Middle-click Camera Menu

Middle-click the camera image, and select Stop listening from the menu.
You will see the icon change from green to grey, to indicate inactivity. Sound should stop on your local speaker

 To Speak to a Remote Site

Open the Resource panel for the remote site, and double-click the remote speaker that you wish to speak
through.
Your local microphone goes green, indicating that your speaking is in progress.

 To Stop Speaking to a Remote Site

Right click your local microphone, and choose Stop call.
Your local microphone goes grey, indicating that your speaking is no longer in progress.
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8 Other procedures

 To Switch a Relay Output (e.g. unlock a door, activate a siren)

Relay outputs can also be switched from the Map (right-click>Set Output / Clear Output).
The action performed when double-clicking a relay in the CathexisVision resource panel is configurable. The
setting is in CathexisVision menu->Settings->General

1. Left double-click to toggle the relay between set and clear, or
Right-click the relay.
> A popup menu offers you the choice of Set output (activate it) or Pulse Output.
2. Select an option and click OK.

>The relay changes state, and the output changes colour . While active the play pause image in the middle
of the Output icon will change from black to white.
3. To clear a set relay, left double-click or right-click >Clear output

 To Pulse a Relay Output (e.g. unlock a door for a defined 4-second period)

Relay outputs can also be pulsed from the Map (right-click>Pulse Output).

Right-click the output and select Pulse output.
> This pulses the output for the time that has been set at the unit. While the output is pulsed the play pause
image in the middle of the Output icon will change from black to white, when it resets it will return to black.

 To Manually Trigger a Site Action

Right-click the Site Action in the Resources Pane and
then click Execute.

Note: This requires 1) Site action setup 2) Assignment of site action to resources pane 3) Appropriate access
rights.
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